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Bezpecnostné opatrenia
Pred pouzitim bezdrétového zariadenia si pozorne precitajte bezpecnostné
opatrenia a oboznamte s nimi Vase deti, aby ste dosiahli spravne a bezpe¢né
pouzivanie Vasho bezdrotového zariadenia. Pre podrobnejSie udaje, pozri
Cast’ “Upozornenia a vystrahy”.

Nezapinajte bezdrotové zariadenia na miestach, kde je
zakazané pouzivat bezdrotové zariadenia, alebo ked by
mohlo pouzitie bezdrotového zariadenia sposobit’ rusenie
alebo ohrozenie.

| =

Nepouzivajte  bezdrotové  zariadenia  pocas  riadenia
motorového vozidla.

B)

Riad’te sa pokynmi alebo nariadeniami v nemocniciach a
zdravotnickych zariadeniach. V blizkosti zdravotnickych
pristrojov vypinajte Vase bezdrotové zariadenie.

s

V lietadle vzdy vypnite VaSe bezdrotové zariadenie, pretoze
moze sposobit’ rusenie riadiacich signalov lietadla.

Bezdrotové zariadenie vypinajte v blizkosti vysoko
citlivych elektronickych zariadeni. Bezdrotové zariadenie
moze ovplyvnit’ vykon funkcie tychto zariadeni.

N

Nepokusajte sa rozoberat bezdrotové zariadenie alebo
jeho prislusenstvo. Servis alebo opravy smie vykonavat’
len kvalifikovany personal.

%

Neukladajte  Vase bezdrotové zariadenie a  jeho
prislusenstvo do schranok so silnym elektromagnetickym
polom.

D

Do blizkosti Vasho bezdrotového zariadenia neklad'te
média na magnetické ukladanie dat. Ziarenie z
bezdrotového zariadenia by mohlo vymazat’ tidaje na nich
uloZené.

Neklad'te Vase bezdrotové zariadenie na miesta s vysokou
teplotou a nepouzivajte ich na miestach s vyskytom
horlavych plynov, ako Cerpacia stanica.

Bezdrotové zariadenie a jeho prislusenstvo drzte mimo
dosahu deti. Nedovol'te ho detom pouzivat’ bez dozoru.

©) =] =

Dodrzujte vSetky zakony a nariadenia o pouzivani
bezdrotovych zariadeni. Pri pouzivani Vasho bezdrétového
zariadenia berte ohlad na zékonné prava a ochranu
stikromia ostatnych.
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Prehlad

HUAWEI E220 USB modem (d’alej oznacovany ako E220) je bezdrotovy USB
modem schvéleny pre pouzitie v sietach GSM 900, GSM 1800, GSM 1800
a UMTS 2100 MHz.

USB modem je mozné pripojit do USB slotu vécSiny pocitacov s operaénym
systémom Windows 2000 a Windows XP.

Po pripojeni E220 s aktivovanou SIM kartou a instalaciou programu ,Mobile
Connect®, ktory je ulozeny v modeme moézete jednoducho vyuzivat nasledujuce
sluzby:

e Ziskat pristup na internet

e Posielat’ alebo prijimat’ textové spravy

e Spravovat’ zoznam kontaktov



2 Obsah balenia

Balenie modemu E220 obsahuje tieto polozky:

e Jeden modem E220 HSDPA USB
e dva USB kable

e Zarucny list

e Navod na pouzitie

Skontrolujte si, prosim, ¢i obsah balenia zodpoveda tomuto zoznamu.
(vratane navodu na pouzitie HUAWEI E220 HSDPA USB Modem User Manual vo
formate PDF a nastavovaci program)

Dva USB kéble



Zoznamte sa s Vasim E220 modemom

Nasledujuci obrazok zobrazuje E220.

usB
rozhrahie

Ukazovatel
Zasuvka na
USIM/SIM kartu

Poznamka:
Zobrazenie je len informac¢né.

Ukazovatel (LED dioda)

Stav ukazovatela Vyznam

Nesvieti E220 je vypnuty.

Blika dvakrat kazdych E220 vyhl'adava siet alebo siet’ nie je dostupna.
2,7 sekundy (zeleno)

Blika raz za Normalny stav GSM siete.

2,9 sekundy (zeleno)

Blika raz za Normalny stav WCDMA siete.

2.9 sekundy (modro)

Svieti (zeleno) Nadviazanie GPRS datovej sluzby.
Svieti (tyrkysovo) Nadviazanie HSDPA datovej sluzby.
Svieti (modro) Nadviazanie WCDMA détovej sluzby.




Zaciname

Minimalne systémové poziadavky

e  Procesor: Pentium 4, frekvencia 1 GHz alebo vyssi

e  Pamit: 128 MB RAM alebo viac

° Hard disk: 50 MB alebo viac

e  Operacny systém: Windows XP (s nainstalovanou aktualizaciou SP 2)

alebo Windows 2000 (s nainstalovanou aktualizaciou SP4)

e  USB modem rozhranie: USB 2.0 full speed

o Rozlisenie obrazovky: 800 x 600 alebo vyssie; odportca sa 1024 x 768
Poznamka:

Uistite sa, ¢i konfiguracia Vasho PC zodpoveda poziadavkam. V
opacnom pripade, nevhodna konfigurdcia moze spdsobit’ znizenie
vykonu Vasho pocitaca.

Priprava zariadenia E220

1) Zo zariadenia E220 vyberte zasuvny slot pre USIM/SIM kartu, ktort don
potom vlozime tak, ako je znazornené na obrazku. Uistite sa, ze karta je
riadne zasunuta na svoje miesto (po vlozeni SIM karty do slotu su viditeI'né
metalické kontakty).

2) Zasuvny slot s kartou potom vlozte do modemu E220, ako je
znazornené na d’alSom obrazku.




InStalacia

Postupy pri instalacii zariadenia E220 sa mozu 1isit’ v zavislosti od operaéného
systému ako Windows XP a Windows 2000. V pripade odlisnosti si pozrite tipy pri
instalacii.

Ako vzor pouzijeme operacny systém Windows XP.

1) Prepojenie E220 s PC

Pozn. Najprv spustite svoj pocita¢. Potom E220 pripojte k pocitacu.

Inak méze pocas instalacie zariadenia E220 dojst’ k chybam.

Na pripojenie E220 k pocitacu pouzite prilozeny USB kabel, ktory je
zobrazeny na nasledujucom obrazku.

Pridavny USB
datovy kabel

Hlavny USB Mini-USB
datovy kabel konektor

B
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1 Mini-USB konektor datového kabla zasurite do E220.

2 USB konektor hlavného aj pridavného datového kable zasunte do prislusnych
rozhrani na po¢itaci.

Poznamka:
E220 je napdjany energiou z PC cez pridavny USB datovy kabel.
Preto sa uistite ¢i je zapojeny do USB rozhrania na PC.

3 Systém automaticky zisti a rozpozna nové zariadenie a v stavovej oblasti
pracovnej plochy zobrazi u




2) Instalacia spravcovského programu E220
Mobile Connect

1 Pripojte E220 k PC.

2 InStalacny program sa spusti automaticky. Ak sa nespusti automaticky, je
potrebné vykonat’ manudlnu instalaciu. Ked'ze sa zariadenie pripdja ako USB
disk, je mozné na tiom prehladavat adresare a subory ako na beznom
externom paméitovom zariadeni. Vyhladajte na nom a dvojklikom spustite
stibor AutoRun.exe ¢im sa inStalacia p usti.

3V dialégovom okne Choose Language zvolte English a kliknite na Next
(Dalej).

4 Postupujte d’alej podl'a pokynov.

5 Kliknite Finish (Ukon¢it’) na dokoncenie instalacie.

Poznamka: Pocas instalacie neodpajate E220.

6 Po ukonceni instalacie sa na pracovnej ploche pocitaca objavi ikona
spravcovského programu Mobile Connect (dalej len Mobile
Connect).

Odpojenie E220 od pocitaca

Pred odpojenim vypnite E220 pomocou funkcie Windows na odpojenie hardvéru.

1 Po dvojkliku na v pravom spodnom rohu obrazovky pocitaca sa zobrazi

dialégové okno Safely Remove Hardware (Bezpecné odstranenie hardvéru).
2 Na vypnutie E220 zvolte Huawei Mass Storage USB Device.

3 Potom ako Vam systém oznami, ze teraz mozete bezpecne odstranit’
zariadenie, E220 odpojte.

Odinstalovanie Mobile Connect

Mobile Connect mozete odinstalovat’ pomocou funkcie operacného systému
Windows Add or Remove Programs (Pridanie alebo odstranenie programov).
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Zaklady Mobile Connect

Spustenie Mobile Connect

1 Pripojte E220 k poc¢itacu a program E220 spustite dvojklikom na ikonu na
pracovnej ploche.

2 Ak vas systém vyzve, aby ste zadali PIN zadajte spravny PIN kod a
kliknite OK.

Ak tri krat po sebe zadate nespravne PIN, Vasa USIM/SIM sa zablokuje. V
tomto pripade pouzite PUK kod (Osobny kod pre odblokovanie). Ak desat’ krat
po sebe zadate nespravny PUK kod, Vasa USIM/SIM karta ostane zablokovana.
V tomto pripade sa obrat'te na Vasho poskytovatel'a sluzby.

Poznamka:

PIN ¢islo a PUK kod poskytuje poskytovatel’ sluzby. Detaily o
zmene, aktivacii a deaktivacii PIN ndjdete v casti "Sprava
PIN".

Zoznamenie sa s Home Screen

Prehlad obsahu Home Screen

Po spusteni Mobile Connect sa zobrazi home screen (ivodna obrazovka):

> Mobile Connect S =lolx|

File Tools Settings Help

W 9 e

Connect Browser SMS Contacts

Signal Network Duration Volume

No Network
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Obrazovku mdzete zvacsit.

» Mobile Connect

Fie Tools Settings Help

> @89

Connect Browser SMS Contacts

&

Inbox 071000 Signal
__ From | Phone Number | Time Content
Write
= Network
=] No Network
Inbox
Connection
d Duration: --
Outbox Volume:
— 4 Profile:
E— < |
Draft Sent Received
i Volume: -- -
Rate
Trash
Top rate: -
—r
- Information
IO New messages:

ot ool New SMS reprts

lkony a klavesové skratky

V nasledujlicej tabulke je zoznam ikon a zodpovedajicich klavesovych skratiek
Mobile Connect.

Ikona/Klavesova Vyznam

skratka

Pripojenie do/Odpojenie zo siete.

D’Q ) ﬁg /F2 poj poj

Spustenie IE (Internet Explorer).
Q 3 p ( plorer)
Q Zobrazenie SMS rozhrania.

/F5

Zobrazenie Contacts (kontaktov).

Y r.
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Informécia o stave zobrazena na pravom paneli sa meni podla prave aktivnej
sluzby. Nasledujuce dve tabulky st prehladom informacii o stave a ich
vyznamu.

Pri zmenSenej obrazovke:

Signal Typ siete a sila signalu. Cim silnejsi signal, tym
viac zobrazenych policok.

Network Informéacia o poskytovatel'ovi sluzby.
Duration Trvanie aktualneho datového pripojenia.
Volume Rozsah aktualneho datového pripojenia.
Profile Pouzity profil pre pripojenie




Menu

1 File
1.1 Connect/Disconnect
1.2 Import Contacts
1.2.1 From File
1.2.2 From USIM/SIM Card
1.3 Export Contacts
1.3.1 To File
1.3.2 To USIM/SIM Card
1.4 Import Message from USIM/SIM Card
1.5 Exit
2 Tools
2.1 Open Browser
2.2SMS
2.3 Contacts
24 Volume Statistic
2.5 Diagnostics
3 Settings
3.1 Choose network
3.1.1 Auto
3.1.2 Manual

1 Sibor
1.1 Pripojenie/Odpojenie
1.2 Import kontaktov
1.2.1 Zo stiboru
1.2.2 Z USIM/SIM karty
1.3 Export kontaktov
1.3.1 Do stboru
1.3.2 Na USIM/SIM kartu
1.4 Import spravy z USIM/SIM karty
1.5 Zavriet
2 Nastroje
2.1 Otvor prehliada¢
2.2 SMS
2.3 Kontakty
2.4 Statistika objemu dét
2.5 Diagnostika
3 Nastavenia
3.1 Vyber siete
3.1.1 Automaticky

3.1.2 Manualne
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3.2 Choose connection type
3.2.1 GPRS Preferred
3.2.2 3G Preferred
3.2.3 GPRS Only
3.2.43G Only
3.3 Band Selection
3.3.1 All Band
3.3.2 GSM900/1800/WCDMA2100
3.3.3 GSM1900
3.4 Modify PIN code
3.5 PIN Code Protection
3.5.1 Validate
3.5.2 Enable
3.5.3 Disable
3.6 Options
3.7 SMS Settings
3.8 Network Connection Settings
4 Help
4.1 HUAWEI Online Support
42  About

3.2 Zvol typ pripojenia
3.2.1 Preferencia GPRS
3.2.2 Preferencia 3G
3.2.3 Iba GPRS
3.2.41ba3G

3.3 Vyber pasma
3.3.1 Vsetky pasma
3.3.2 GSM900/1800/WCDMA2100
3.3.3 GSM1900

3.4 Zmena PIN

3.5 Ochrana PIN
3.5.1 Over
3.5.2 Aktivuj
3.5.3 Zru§

3.6 Moznosti

3.7 Nastavenia SMS

3.8 Nastavenia pripojenia k sieti

4 Pomoc

4.1 HUAWEI Online podpora
4.2 O programe



Internet

V programe

je prednastaveny profil ,,Orange internet s nastavenymi

parametrami pre pripojenie, ktory umoziiuje okamzité pripojenie do

siete Internet.

Pozn.:

Tento profil nie je mozné zmenit ani vymazat.

V pripade, ak potrebujete pre pripojenie pouzit’ iny profil, postupujte podla nasledujuceho

navodu na vytvorenie nového profilu.

Nastavenia pripojenia k sieti

Vytvorenie

profilu

Zvol'te Settings > Network Connection Settings.(Nastavenia > Nastavenia
pripojenia k sieti).

Krok

Postup

1 Kliknite New (Novy).

2 Zadajte Profile name (Nazov profilu).
3 Zadajte APN, IP, autentifikaciu, DNS, WINS, a overovaci protokol.
4 Kliknite Save (Uloz).

Poznamka:

Obratte sa na Vasho poskytovatela sluzby pre podrobnosti o
pripojeni k sieti.

Pokial’ pouzivate pre pripojenie dynamické overovanie uzivatel'ského
mena a hesla, zaskrtnite vol'bu ,,Ask for username and password®. Po
zaskrtnuti  budete pri  kazdom spojeni vyzvani k zadaniu
uzivateI'ského mena a hesla.
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Vymazanie profilu

Zvol'te Settings > Network Connection Settings. (Nastavenia > Nastavenia
pripojenia k sieti). Potom spravte nasledovné:

Krok Postup

1 Zvol'te meno profilu v Choose Profile Name (Vyberte meno profilu).
2 Kliknite Remove > OK (Odstran > OK).

Zmena profilu

Zvol'te Settings > Network Connection Settings.... (Nastavenia > Nastavenia
pripojenia k sieti). Potom spravte nasledovné:

Krok Postup

Zvol'te profil v Choose Profile Name (Vyberte meno profilu).
Kliknite Modify (Uprav).

Vykonajte zmeny v profile.

Kliknite Save (Uloz).

BN —

Pristup na internet

Do Internetu sa mozete pripojit pomocou 3G alebo GPRS. Zvol'te Settings >
Network Connection Settings. (Nastavenia > Nastavenia pripojenia k sieti).
Potom spravte nasledovné:

Krok Postup

1 Zvol'te profil v Choose Profile Name (Vyberte meno profilu) OK.

2
Kliknite na g,g pre 3G alebo GPRS pripojenie.

3 Po zobrazeni spravy o uspe$nom pripojent,

kliknite na Q alebo spustite prehliada¢ operacného
systému. Teraz mate pristup na internet.

Kliknite na ﬂg pre ukonéenie pripojenia.
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Po tispesnom pripojeni sa zobrazia nasledovné udaje o pripojeni na siet’:

Trvanie aktudlneho pripojenia
Objem prenesenych dat pocas aktualneho pripojenia
Rozsah, rychlost’ a najvyssia rychlost’ odosielanych a prijimanych dat

Statistika objemu dat

Maozete si prezerat’ podrobnu  Statistiku prenesenych dat. Zvol'te Tools
> Volume Statistic...(Néstroje > Statistika objemu dat) a uvidite:

e Last Volume Statistic (Statistika objemu posledného pripojenia):
objem dat pri poslednom pripojeni, ako aj objem poslanych dat,
prijatych dat a trvanie pripojenia

o  Total Volume Statistic (Celkova statistika objemu dat):objem dat z
vSetkych pripojeni ako aj objem poslanych dat, prijatych dat a
trvanie pripojenia

e Last Reset Time (Cas posledného vynulovania): &as posledného
vynulovania

e  Reset (Vynulyj): kliknite na vynulovanie

Poznamka:

Statistika objemu dat mé len informagny charakter.
Ak ste este ani raz nevynulovali udaje, ¢as posledného vynulovania nebude
zobrazeny.
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SMS

Posielanie alebo prijimanie spravy

Pisanie spravy

Kliknite & alebo vyberte Tools > SMS (Néstroje > SMS) a zobrazi sa SMS

rozhranie.
Krok Postup
1 Kliknite Write (Pisanie) a zobrazi sa rozhranie na pisanie sprav.

2 Vlozte telefonne ¢islo jednym z nasledujiicich sposobov:

e Vlozte telefonne cislo: Do pola Contacts (Kontakty) vpiste
telefonne ¢islo, na oddelenie viacerych ¢isiel pouzite bodkociarku.

e Vyberte kontakt: Kliknite na Contacts (Kontakty). Vyberte jeden
alebo viac kontaktov a kliknite na OK. V dialégovom okne
Please select number (Prosim, vyberte ¢islo) vyberte telefonne
Cisla, na ktoré chcete odoslat’ SMS a kliknite na OK.

3 Napiste spravu. V pravom hornom rohu rozhrania je zobrazeny
pocet ostavajucich znakov (Character(s) left) a pocet Casti, do
ktorych je sprava rozdelena.

4 Kliknite Send (Posli) na odoslanie spravy. Po odoslani sa sprava
automaticky ulozi v zlozke Outbox (Schranka odchadzajicich
sprav). Ak sa spravu nepodari odoslat’, zobrazi sa vyzva s otazkou,
¢i ju chcete opdt’ poslat. Ak posielanie zrusite, sprava sa
automaticky ulozi v Outboxe.

Kliknite Save (Uloz) na ulozenie spravy ako Draft (Koncept).

Kliknite Clear (Zmaz) zmazanie telefénneho ¢isla a spravy.
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Poznamka: e Na vyber viac kontaktov stlacte a podrzte klavesu Shift alebo

Ctrl.

e Mobile Connect podporuje funkciu skupinového posielania.
Mozete poslat’ spravu az na 20 telefonnych cisiel.

o Kazda sprava moze obsahovat’ 160 anglickych pismen. Ak
sprava obsahuje viac ako 160 anglickych pismen, je rozdelend
na viac ¢asti, ktoré su odosielané za sebou..

o Mozete postupovat podla dvoch vysSie uvedenych
spdsobov zadania telefonneho ¢isla ako prijemcu spravy.

Inbox

Inbox je zlozka na prijaté spravy. Jej kapacita je 1000 sprav.

Ak je Inbox plny a prijmete novl spravu, najstarSia sprava sa automaticky
presunie do Trash (Odpadkového kosa).

Ak mate neprecitané spravy, ich pocet je zobrazeny na pravom paneli uvodnej
obrazovky.

Na pristup do Inboxu kliknite na Inbox v SMS rozhrani.

Prezeranie spravy
1 Spravu si mozete pozriet’ v Inboxe.

Krok Postup

1 Kliknite na Q alebo vyberte Tools > SMS (Nastroje > SMS).
Zobrazi sa SMS rozhranie.

2 Kliknite na Inbox na pristup do schranky. Dvojklikom vyberte
spravu, ktoru chcete Citat’.

V Inboxe su dva typy ikon:

[558 : Neprecitané spravy
[ : Precitané spravy
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2 Prezretie spravy pri jej prichode.
Pri prichode novej spravy mozete pocut upozorfiujici téon alebo uvidiet
upozoriiujuce okno. Pre podrobnosti, pozrite ¢ast’ "Systémové nastavenia".

e S aktivovanou funkciou upozortiujicich ténov:
Pri prichode novej spravy budete pocut’ upozoriujuci ton.

Krok Postup

U Kiiknite na &5 alebo vyberte Tools > SMS (Néstroje > SMS). Zobrazi sa
SMS rozhranie..

2 Kliknite na Imbox na pristup do schranky. Dvojklikom vyberte
spravu, ktoru cheete citat’.

e  Saktivovanou funkciou upozoriujiceho okna:
Pri prichode novej spravy sa zobrazi upozortiujiice okno.

Kliknite Aby...
View (Prezri) ..ste mohli spravu precitat’.
Close (Zavri) ...ste zavreli vystrazné okno.

Odpovedanie na spravu
Na prijatu spravu mozete odpovedat’ v Inboxe.

Krok Postup

1 Vyberte alebo dvojklikom otvorte spravu. Potom kliknite na Reply
(Odpovedat).

2 Telefonne Cislo odosielatela je zobrazené v poli Contacts
(Kontakty). Mozete ho menit’ podl'a potreby.

3 Napiste spravu.
4 Kliknite na Send (Posli).
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Preposlanie spravy
Prijaté spravy mozete poslat’ d’alej.

Krok Postup

1 Vyberte alebo dvojklikom otvorte spravu. Potom kliknite na
Forward (Preposlat).

2 Zadajte telefonne cCislo prijemcu, alebo kliknite na Contacts
(Kontakty) a vyberte kontakt.

3 Text spravy je zobrazeny v textovom poli. Mozete ho menit podla
potreby.

4 Kliknite na Send (Posli).

Vymazanie spravy
Vymazanie prijatej spravy.

Krok Postup

1 Vyberte jednu alebo viac sprav.
Dvojklikom si spravu mozete precitat’.

2 Kliknite na Delete (Vymaz). Sprava sa presunie do Trash (Odpadkovy
kos).

UloZenie telefénneho ¢Cisla

Telefonne c¢islo z prijatej spravy mozete ulozit’ ako kontakt.

Krok Postup

1 Vyberte alebo dvojklikom otvorte spravu a kliknite na Get
Number (Pouzi ¢islo).

2 Zobrazi sa rozhranie kontaktov New (Nové) a telefonne Eislo
odosiclatel'a spravy sa zobrazi v poli Mobile Number (¢islo
mobilného telefonu).

3 Zadajte informacie o telefénnom &isle.

4 Kliknite na Save (Uloz).

Export spravy

Prijaté spravy mozete exportovat’ vo forme suboru. Tento subor méze byt vo
formate .txt alebo .csv.

Krok Postup
1 Vyberte jednu alebo viac sprav.
2 Po pravom kliknuti na okno vyberte Export to file (Export do siboru).
3 Zvol'te cestu a zadajte meno suboru.
4 Kliknite na Save (Uloz).
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Uzamykanie/odomykanie spravy

Aby ste sa vyhli nechcenému vymazaniu spravy, mozete tuto v Inboxe
uzamknut. Rovnako mézete odstranit” ochranu proti vymazaniu.

Krok Postup
1 Vyberte jednu alebo viac sprav.
2 Po pravom kliknuti na okno vyberte Lock (Uzamkni) alebo Unlock
(Odomkni).
Poznamka:

Uzamknutd sprava je oznacend .

Outbox

Outbox je zlozka na poslané spravy s kapacitou az 1000 sprav. Po naplneni
Outboxu, pri ulozeni novej spravy sa najstarSia automaticky presuva do Trash
(Odpadkovy ko3).

Na pristup do Outboxu kliknite na Outbox v SMS rozhrani.

Prezeranie spravy
Spravu si mozete pozriet’ v Outboxe.

Krok Postup

1 Mozete si prezerat’ vSetky spravy v Outboxe.
2 Spravu otvorite dvojklikom.

Posielanie spravy
Spravu mozete poslat’ aj z Outboxu.

Krok Postup

1 Vyberte alebo dvojklikom otvorte spravu. Potom kliknite na Send
(Posli).

Mozete zakazdym poslat’ spravu viacerym prijemcom. Vyberte
viacero sprav a kliknite Send (Posli).

2 Telefonne ¢islo prijemcu je zobrazené v poli Contacts (Kontakty).
Mozete ho menit’ podl'a potreby.

3 Napiste spravu.

4 Kliknite na Send (Posli).
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Preposlanie spravy
Z Outboxu mozete preposlat’ poslané spravy.

Krok Postup

1 Vyberte alebo dvojklikom otvorte spravu. Potom kliknite na
Forward (Preposlat).

2 Zadajte telefonne Cislo prijemcu, alebo kliknite na Contacts (Kontakty)
a vyberte kontakt.

3 Zobrazi sa text spravy. Mozete ho menit’ podl'a potreby.

4 Kliknite na Send (Posli).

Vymazanie spravy
Spravu mozete vymazat’:

Krok Postup

1 Vyberte jednu alebo viac sprav a kliknite na Delete (Vymaz).

Dvojklikom otvorte spravu a kliknite na Delete (Vymaz).
2 Sprava sa presunie do Trash (Odpadkovy kos).

Ulozenie telefénneho &isla
Telefonne Cislo z poslanej spravy mozete ulozit’ ako kontakt.

Krok Postup

1 Vyberte alebo dvojklikom otvorte spravu a kliknite na Get
Number (Pouzi ¢islo).

2 Zobrazi sa rozhranic New (Nové) a telefonne Cislo odosiclatela
spravy sa zobrazi v poli Mobile Number (¢islo mobilného telefonu).

3 Zadajte informacie o telefonnom cisle.

4 Kliknite na Save (Uloz).

Export spravy

Poslané spravy mozete exportovat’ vo forme suboru. Tento siibor moze byt vo
formate .txt alebo .csv.

Krok Postup

1 Vyberte jednu alebo viac sprav.

2 Po pravom kliknuti na okno vyberte Export to file (Export do suboru).
3 Zvol'te cestu a zadajte meno suboru.

4 Kliknite na Save (Uloz).
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Uzamykanie/odomykanie spravy

Aby ste sa vyhli nechcenému vymazaniu spravy, mozete tuto v Outboxe
uzamknut’. Rovnako méZzete odstranit’ ochranu proti vymazaniu.

Krok Postup
1 Vyberte jednu alebo viac sprav.
2 Po pravom kliknuti na okno vyberte Lock (Uzamkni) alebo Unlock
(Odomkni).
Poznamka:

Uzamknutd sprava je oznacena a

Draft

Spravu mozete ulozit’ ako koncept. V zlozke Draft mozete ulozit' az 1000
sprav. Ak ulozite spravu ako koncept ulozi sa iba jej obsah.

V SMS rozhrani, kliknite na Draft.

Uprava spravy
Koncept mozete d’alej upravovat’.

Krok Postup

1 Vyberte koncept a kliknite na Edit (Uprav).

Dvojklikom otvorte koncept.
2 Spravu upravte vo Write (PiS) rozhrani potom kliknite na Send (Posli),
Save (Uloz), alebo Clear (Zmaz).

Vymazanie spravy
Koncept mozete vymazat'.

Krok Postup

1 Vyberte jeden alebo viac konceptov a kliknite na Delete (Vymaz).
2 Koncept sa presunie do Trash (Odpadkového kosa).
3 Kliknite na Save (Uloz).

Trash (Odpadkovy k6s)

V Odpadkovom kosi st ulozené spravy odstranené z Inboxu, Outboxu, a Draft.
Kapacita Odpadkového kosa je az 1,000 sprav.

Ak je Trash plny a poslete do neho novu spravu, najstarsia sprava sa automaticky
vymaze. Na SMS rozhrani, kliknite na Trash (Odpadkovy kos).
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Obnovenie spravy
Spravu z odpadkového kosa mozete obnovit'.

1 Vyberte Jednu alebo viac sprav a kliknite na Restore (Obnov).

2 Sprava je obnovena.

Vymazanie spravy
Ak vymazete spravu z Odpadkového kosa, je natrvalo vymazana.

1 Vyberte jednu alebo viac sprav a kliknite Delete (Vymaz).
2 Kliknite OK.

Export spravy

Spravy mozete exportovat’ vo forme suboru. Tento subor musi byt vo formate .txt
alebo .csv.

Vyberte jednu alebo viac sprav.

Po pravom kliknuti na okno vyberte Export to file (Export do suboru).
Zvol'te cestu a zadajte meno stiboru.

Kliknite na Save (Uloz).

AN —

V schranke Reports (Vypisy) mozete ulozit’ az 1,000 vypisov o doruceni. Ak je
schranka plna a pride novy vypis, najstar$i vypis sa automaticky zmaze.

Na SMS rozhrani, kliknite na Reports (Vypisy).

1 Vyberte jeden alebo viac vypisov a kliknite na Delete (Delete).
2 Kliknite na OK.
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Export vypisu o doruceni

Vypisy o doruc¢eni mozete exportovat’ vo forme suboru. Tento subor musi byt vo
formate .txt alebo .csv.

Krok Postup
1 Vyberte jednu alebo viac vypisov o dorucen.
2 Po pravom kliknuti na okno vyberte Export to file (Export do stboru).
3 Zvol'te cestu a zadajte meno suboru.
4 Kliknite na Save (Uloz).

Sprava importu sprav

Z USIM/SIM karty mozete importovat’ spravy do Mobile Connect.

Krok Postup

1 Vyberte File > Import Message from USIM/SIM Card...(Subor >
Import sprav z USIM/SIM Kkarty).
2 Spravy st jednotlivo importované do zloziek Inbox, Outbox, alebo
Draft programu Mobile Connect.

Nastavenia SMS

Vyberte Settings > SMS Settings (Nastavenia > Nastavenia SMS) a zobrazi sa
rozhranie nastavenia SMS.

Moznost’ Opis
Reports Mozete aktivovat' (Enable) alebo zablokovat' (Disable) tuto
funkeciu.
S aktivovanou funkciou, po spesnom odoslani spravy
dostanete vypis o doruceni.

Use the same  Nastav, aby prijemca pouzil to isté ¢islo SMS centra pri
SMS center odpovedi na spravu.
for reply
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Moznost’ Opis

SMS  bearer  Nastavte doménu nosica posielajuceho spravu.

domain e Okruhové prepajané (CS): spravy su posielané cez CS
e doménu.

e Paketovo prepajané (PS): spravy st posielané cez PS
“doménu.

Validity Doba platnosti spravy ulozenej v SMS centre.

SMC number ~ Cislo SMS centra je dodané s USIM/SIM kartou. Po
vlozeni USIM/SIM karty je toto pole automaticky
vyplnené.

Ak jej toto pole prazdne alebo ste ho nechtiac vymazali,
poziadajte Vasho poskytovatela sluzby o opitovné
poskytnutie tohto Cisla.

Poznamka:

Ak USIM/SIM karta nepodporuje funkciu vypisov o doruceni a
poziadavka o zasielanie vypisov o doruceni je neplatnd, obrat'te sa
na poskytovatela sluzby o poskytnutie podrobnosti.
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1 0 Kontakty

V Mobile Connect mozete mat’ ulozenych az 1,000 kontaktov.

Kontakty mozete vytvarat’, upravovat’ alebo mazat. Na kontakt mozete poslat
spravu alebo zavolat’. Kontakty tiez mozete importovat alebo exportovat’.

Sprava kontaktov

Kliknite na ﬁ alebo vyberte Tools > Contacts (Nastroje > Kontakty). Zobrazi sa
rozhranie Contacts (Kontakty).

1 Kliknite na New (Nové).

2 Vpiste obsah do poli Name, Mobile Number, Home Number,
Office Number, E-mail (Meno, ¢islo mobilného telefonu, domace ¢islo,
¢islo do zamestnania, e-mail) a/alebo Comments (Komentar).

3 Kliknite na Save (Uloz).

1 Vyberte alebo dvojklikom otvorte kontakt a kliknite na Edit (Uprav).
2 Upravte kontakt.
3 Kliknite na Save (Uloz).
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1 Vyberte jeden alebo viac kontaktov. Potom kliknite na Delete (Vymaz).
2 Kliknite na OK.

Na vybrany kontakt v adresari mozete poslat’ spravu. Spravte nasledovné:

1 Vyberte jeden alebo viac kontaktov.
2 Kliknite na Send (Posli). Mobile Connect nacita telefénne ¢islo a zobrazi
sa rozhranie Write (Pisanie).

3 Telefonne ¢islo sa zobrazi v poli Contacts (Kontakty). Napiste spravu
akliknite na Send (Posli).

1 Kliknite na Search (Hl'adaj).

2 Vyberte jednu z polozick Name, Mobile, Family, Office (Meno, ¢islo
mobilného telefonu, priezvisko, zamestnanie) alebo E-mail z rolovacicho
zoznamu v Casti Condition (podmienka).

o Zadajte obsah textového pol'a Value (Hodnota).

e Vpoli Matching Type (Druh zhody) moézete zadat Match Whole
Word Only (Iba zhoda celého slova) a/alebo Match Case (Zhoda
velkosti pisma.)

3 Kliknite na Search Now (Za¢ni hl'adat).
4 Kliknite na Stop Search (Zastav hl'adanie) na zastavenie hl'adania.




Import/Export kontaktov

Import kontaktu

Kontakty mozete do Mobile Connect importovat z USIM/SIM karty alebo zo
stiboru.

Import kontaktu zo stiboru

Mozete importovat’ kontakty do Mobile Connect zo suboru. Stibor musi byt
vo formate .txt alebo .csv.

Krok Postup

1 Vyberte File > Import Contacts > From File (Stibor > Import kontaktov
>70 stuboru).

2 Vyberte subor v dialégovom okne Open (Otvor).

3 Kliknite na Open (Otvor) na import suboru do Mobile Connect.

Import kontaktu z USIM/SIM karty
Mézete importovat’ kontakty do Mobile Connect z USIM/SIM karty.

Krok Postup

1 Vyberte File > Import Contacts > From USIM/SIM Card (Stbor >

Import kontaktov >Z USIM/SIM karty)

2 Mozete zvolit™:
Move Import (Presuii): Kontakty na USIM/SIM karte sa vymazu.
Copy Import (Kopiruj): Kontakty ostanti na USIM/SIM Kkarte.

3 Kliknite na OK. Potom vyberte Mobile, Home (Cislo na mobilny
telefon, domaca linka) alebo Office (Cislo do zamestnania) a

nastavte, ¢i aplikovat’ operaciu na vsetky polozky. Potom kliknite na
OK.

4 Po ukonceni importu, objavi sa sprdva oznamujuca vysledok
importu.
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Export kontaktu

Kontakty z Mobile Connect mézete exportovat’ na USIM/SIM kartu alebo do
suboru.

Export kontaktu do stiboru

Krok Postup

1 Vyberte File > Export Contacts > To File (Stbor > Export
kontaktov > Do suboru). Potom vo vysuvacom dialogovom
okne kliknite OK.

2 V dialégovom okne Save as (Uloz ako), vlozte meno suboru
a koncovkou .csv.

3 Kliknite Save (Uloz).

Export kontaktu na USIM/SIM kartu

Krok Postup
1 Vyberte jeden alebo viac kontaktov.
2 Vyberte File > Export Contacts > To USIM/SIM Card (Subor >

Export kontaktov > Na USIM/SIM kartu).
3 Kliknite OK.

Krok Postup
4 Po ukonceni exportu, objavi sa sprava oznamujica vysledok
exportu.
Poznamka:

Ak nevyberiete Ziaden kontakt, funkcia nie je dostupna.

Pocet kontaktov, ktory mozete ulozit' zavisi od kapacity
USIM/SIM karty.

Ak pocet exportovanych kontaktov prekroci kapacitu
USIM/SIM, Mobile Connect automaticky zastavi operaciu.
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1 1 Nastavenia a diagnostika

Nastavenie siete

E220 podporuje manudlne alebo automatické vyhladavanie siete. Spdsob
vyhladavania vyberiete v Settings > Choose Network (Nastavenia > Vyber
siete) a vyberte jednu z nasledujucich moznosti:
e Auto: E220 automaticky vyhlada a prihlasi sa do siete.
. Manual: Mozete manualne vyhl'adat’ siete a vybrat, do ktorej sa E220
prihlési.

Vyber typu pripojenia

Na nastavenie typu pripojenia vyberte Settings > Choose Connection Type
(Nastavenia > Zvol typ pripojenia).

MozZnost’ Opis
Preferencia GPRS Ak je to mozné, E220 vyberie GPRS siet’.
Preferencia 3G Ak je to mozné, E220 vyberie 3G siet’.
Iba GPRS E220 vyberie vyluéne GPRS siet’.
Iba 3G E220 vyberie vylu¢ne 3G siet’.

Vol'ba pasma

Mozete nastavit’ pracovné pasmo pre E220. Po nastaveni, E220 mdze pracovat’

iba v prednastavenom pracovnom pasme.
Vyberte Settings > Band Selection (Nastavenia >Vyber pasma) .Potom mozete
vybrat’ All Band (Vsetky pasma), GSM900/1800/WCDMA2100 alebo GSM1900.
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Sprava PIN

PIN ochratiuje USIM/SIM kartu pred neautorizovanym pouzitim. PIN je
dodavané s USIM/SIM kartou. PIN mdzete zmenit, rovnako ako aj mozete
nastavit, ¢i ma E220 ziadat’ zadavanie PIN pri spusteni.

1 Vyberte Settings > Modify PIN Code (Nastavenia > Zmena PIN).

2 Zadajte platné PIN a nové PIN, a potom zadajte nové ¢islo este raz

na potvrdenie.
3 Kliknite OK.

Mozete aktivovat’ alebo zablokovat’ zadavanie PIN pri spusteni E220.

1 Vyberte Settings > PIN Code Protection (Nastavenia >Ochrana PIN).
2 Vyberte Enable (Aktivuj) alebo Disable (Deaktivuj). Zadajte PIN.

o Aktivuj: Pri Starte E220 je potrebné zadat’ PIN.

o  Deaktivuj: Nie je potrebné zadat’ PIN pri spusteni E220.
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Nastavenia systému

Medzi nastavenia systému patri rezim spustenia Mobile Connect, rezim
upozornenia na spravy, a pohotovostny rezim/ hibernacia PC.

Vyberte Settings > Options (Nastavenia >Moznosti).

Nastavenia pri Starte

Kliknite na zalozku Startup (Start) na nastavenie nasledovnych poloziek

Moznost’ Opis

Launch  application Mobile Connect sa spusti pri Starte systému Windows.
on windows start up

Start main  window Okno Mobile Connect je pri spusteni minimalizované.
minimized

Check the unread  Pri spusteni Mobile Connect skontroluje
message(s) while  neprecitané spravy na USIM/SIM Kkarte a E220.
starting

Poznamka:

Kliknite na Default (Povodné nastavenia) na obnovenie
povodnych nastaveni.
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Nastavenie upozorneni na SMS

Vyberte zalozku SMS Alerts (Upozornenia na SMS) na nastavenie nasledovnych
poloziek.

Moznost’ Opis

Alert window Oznacte ramcek Alert window (Upozortiujice
okno). Ked pride novd sprava, zobrazi sa
upozoriujuce okno. Mozete:

o Kliknut na View (Prezri) na otvorenie spravy.
e Kliknut na Close (Zavri) na zatvorenic
upozoriujuceho okna.

Alert tone Po vybrani zvukového stiboru je tento prehrany vzdy,
ked’ pride nova sprava.

o Kliknite na Browse (Prezeraj)a vyberte zvukovy
subor.

o Kliknite na Play (Hraj) na vypocutie zvukového
siboru.

Poznamka:

Zvukové stbory pre SMS musia byt’ vo formate *.wav alebo *.mid.
Ak kliknete na Default (Povodné nastavenia), sa nastavia spat’ na
poévodné hodnoty.

Nastavenie pohotovostného rezimu/rezimu spanku

Kliknite na zalozku Standby/Hibernate na nastavenie nasledovnych poloziek.

Moznost’ Opis

Prevent Standby/Hibernate Zabrani PC prepnut sa do pohotovostného
rezimu alebo rezimu spanku .

Alow Standby/Hibernate Umozni PC prepnut’ sa do pohotovostného
rezimu alebo rezimu spanku.

Poznamka:

Ak  kliknete na Default (Povodné nastavenia), nastavenia
pohotovostného rezimu/rezimu spanku  sa vratia na pdvodné
nastavenia.
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Diagnostika

Mozete zistit’ nastavnia E220 a USIM/SIM Kkarty.
Vyberte Tools > Diagnostics (Nastroje > Diagnostika):

e Messages in USIM/SIM card:
Format je "XX/YY". XX oznaCuje pocet sprav a YY je kapacita
USIM/SIM Karty.
e Contacts in USIM/SIM card:
Format je "XX/YY". XX oznaCuje pocet kontaktov a YY je kapacita
USIM/SIM Kkarty.
IMEI number: IMEI ¢islo E220.
API Version: API verzia.
Firmware Version: Verzia firmvéru E220.
Hardware Version: verzia hardvéru E220.
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1 2 Specifikacie

Polozka Opis
Technicky Standard ~ 3GPP RS
Standard USB USB2.0
rozhrania

Prenosovy systém

GSM/GPRS/EDGE: 900 MHz/1800 MHz/1900 MHz
HSDPA /WCDMA: 2100 MHz

Frekvencné
pasma

GSM/GPRS/EDGE 900 MHz
UL: 880 MHz-915 MHz

DL: 925 MHz960 MHz
GSM/GPRS/EDGE 1800 MHz
UL: 1710 MHz-1785 MHz
DL: 1805 MHz-1880 MHz
GSM/GPRS/EDGE 1900 MHz
UL: 1850 MHz-1910 MHz
DL: 1930 MHz-1990 MHz
HSDPA/WCDMA 2100 MHz
UL: 1920 MHz-1980 MHz
DL: 2110 MHz-2170 MHz

Vystupny vykon

HSDPA/WCDMA 2100 MHz: Power Class 3, +24 dBm+1/-3
GSM/GPRS 900 MHz: Power Class 4, +33 dBm+2
GSM/GPRS 1800 MHz: Power Class 1, +30 dBm+2
GSM/GPRS 1900 MHz: Power Class 1, +30 dBm+2

EDGE 900 MHz: Power Class E2, +27 dBm+3

EDGE 1800 MHz: Power Class E2, +26 dBm=+3

EDGE 1900 MHz: Power Class E2, +26 dBm+3
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Polozka Opis

Sluzby Datové sluzby:
GSM CS: UL 9.6 kbit/s/DL 9.6 kbit/s
GPRS: UL 26.8 kbit/s/DL 53.6 kbit/s
EDGE: UL 118.4 kbit/s/DL 236.8 kbit/s
WCDMA CS: UL 64 kbit/s/DL 64 kbit/s
WCDMA PS: UL 384 kbit/s/DL 384 kbit/s
UL WCDMA/DL HSDPA: UL 384 kbit/s/DL 3.6

Mbit/s
SMS:
GSM, GPRS, WCDMA, HSDPA, EDGE
Rozmery 89.37 mm x 42.61 mm x 14.50 mm
(DxSxV)
Hmotnost’ Priblizne 50 g
Sposob Cez dve USB rozhrania
napéjania
Prevadzkova -10 °C az +55°C
teplota

Teplota pri skladovani -40 °C az +70°C
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1 3 NajcastejSie otazky

Ako mam posudit’ ¢i je E220 spravne pripojeny k PC?

Potom, ako pripojite E220 k pocitacu, v spravcovi zariadeni sa zobrazia ikony
zariadeni, konkrétne, “HUAWEI Mobile Connect-3G Modem” a “HUAWEI
Mobile Connect-3G PC UI Interface”.

Ak sa pred ikonami objavi zlty vykricnik alebo iné znaky, naznacuje to
nespravne pripojenie E220. Pripojte E220 znovu.

€o mam robit’ ak sa E220 nepodari pripojit’ k internetu?

1 Skontrolujte, Ze SIM karta je riadne vlozena do slotu modemu.

1 Uistite sa E220 je v oblasti s prijmom signalu a skontrolujte silu signalu.

2 Uistite sa, ¢i ste mate sluzbu bezdrotového pristupu na siet’. Obrat’te sa na
Vasho poskytovatel'a sluzby pre podrobnosti.

3 Ak to mate sluzbu bezdrotového pristupu na siet’, pozrite si cast' "Internet" na
nastavene pristupu na siet’ .

Ak pouzivam funkciu “Paste” (Vloz) pri pisani spravy, zobrazi sa len
cast’ spravy. Preco?

Textova sprava moze obsahovat maximalne 1000 znakov. Ak velkost
vkladanej Casti presahuje tento limit, presahujiica Cast je automaticky
zmazana.

Ked’' dostanem novu spravu, nezobrazi sa Ziadne upozornujtce okno.
preco?
Uistite sa, Ci ste aktivovali funkciu zobrazovania upozoriiujiiceho okna.

Vyberte Settings > Options (Nastavenia > Moznosti). Potom vyberte zalozku
Prompt a v Message Alerts Settings (Nastavenie upozornenia na spravu)
oznatte raméek Display alerts when a message is received (Zobraz
upozornenia pri prijati spravy).

Po spusteni Mobile Connect, systém zobrazi vyzvu “There are
some unread messages in USIM/SIM card. Do you want to
import them to the computer?” (Mate neprecitané spravy na
USIM/SIM karte. Chcete ich importovat do pocitaca?) Ak
vyberiem “Nie”, ¢o ak budem chciet’ importovat’ neskér?

Vyberte File > Import Message from USIM/SIM Card (Stabor > Import spravy
z USIM/SIM karty) na import sprav do Mobile Connect z USIM/SIM karty.

Nemoézem vlozit’ telefénne Cislo. Preco?

Je povolené zadat’ iba znaky “0123456789#*+”. Uistite sa, Ci st vSetky znaky
telefonneho Cisla platné.
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1 4 Upozornenia a bezpecnostné
opatrenia
Elektronické zariadenia

Vypnite Vase bezdrotové zariadenie v blizkosti vysoko citlivych
elektronickych zariadeni. Bezdrotové zariadenie modze ovplyvnit funkciu
tychto zariadeni.

Medzi takéto zariadenia patria sluchové pomdcky, kardiostimulatory, poziarne
hlasiace systémy, automatické brany a iné automatické ovladacie zariadenia.
Ak pouzivate elektronické lieCebné zariadenie, poradte sa s vyrobcom
zariadenia a nechajte si potvrdit, Ze radiové viny neovplyviuji funkciu tohto
elektronického zariadenia.

Nemocnica

Dbajte na nasledujice miesta v nemocniciach a zdravotnickych zariadeniach:

Neberte bezdrotové zariadenie do operacnych miestnosti, na jednotku
intenzivnej starostlivosti alebo na srdcovo-cievne oddelenie.

Nepouzivajte bezdrotové zariadenie na miestach poskytovania lekarskej
starostlivosti, kde je zakdzané pouzivat’ takéto zariadenia.

Miesta s horlavymi latkami a vybusninami

Ak sa nachadzate na mieste, kde sa nachadzaji horlavé latky alebo
vybusniny, odpojte Vase bezdrétové zariadenie od PC a vypnite PC, aby ste
zabranili vybuchu a poziaru. Medzi takéto miesta patria:

Cerpacia stanica

Miesta, kde sa skladuji paliva (ako 16zka pod palubou lode)
Zariadenia/vozidla na prepravu a skladovanie paliv a chemikalii

Miesta s chemickymi latkami a Ciastockami (napr.: granule, prach,
kovovy prach) vo vzduchu

Miesta s oznac¢enim "Nebezpecenstvo vybuchu

Miesta s oznac¢enim "Vypnite obojsmerné bezdrotové zariadenia“

Miesta, kde sa vo v§eobecnosti odporuca zastavit’ motor alebo vozidlo
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Bezpecnost’ premavky

Dodrzujte prislusné predpisy v mieste alebo krajine, kde sa nachadzate. Aby
ste predisli dopravnym nehodam, nepouzivajte Vase bezdrétové zariadenie
pocas riadenia vozidla.

Zabezpecte bezdrotové zariadenie vo svojom drziaku. Neklad'te bezdrétové
zariadenie na sedadlo alebo iné miesta, kde sa mdze uvolnit pri nahlom
zastaveni alebo kolizii. Bezdrotové zariadenie pouzivajte len po zastaveni
vozidla na bezpe¢nom mieste.

Neklad’te bezdrotové zariadenie na airbag alebo do miesta vystrelenia airbagu.
V opa¢nom pripade Vas kvoli velkej sile pri vystreleni airbagu moze
bezdrotové zariadenie zranit'.

Dodrziavajte predpisy a nariadenia leteckych spolocnosti. Na palube alebo v
blizkosti lietadla, odpojte bezdrotové zariadenie od PC a PC vypnite. Na
miestach, kde je zakdzané pouzivat bezdrotové zariadenie, zariadenie
nepouzivajte. V opactnom pripade moze bezdrotovy signal bezdrotového
zariadenia rusit’ riadiace signaly lietadla. Pred nastipenim do lietadla odpojte
bezdrétové zariadenie od PC a PC vypnite.

Skladovanie

Neklad'te magnetické pamdtové média ako magnetické karty a diskety do
blizkosti bezdrétového zariadenia. Ziarenie z bezdrétového zariadenia moze
vymazat’ data na nich ulozené.

Neklad'te Vase bezdrotové zariadenie do schranok so silnym magnetickym
polom, ako napriklad indukény spordk a mikrovinné rura. V opacnom pripade
moze nastat’ chyba obvodu, poziar alebo vybuch.

Nenechavajte Vase bezdrotové zariadenie na vel'mi horucich alebo vel'mi
studenych miestach. V opa¢nom pripade to mdze spdsobit’ zlyhanie
vyrobku, poziar alebo vybuch.

Neklad'te Vase bezdrétové zariadenie do vrecka na zadnej strane nohavic alebo
sukne, aby ste zabranili jeho poskodeniu pri sadnuti si.

Bezpecnost’ deti

Bezdrotové zariadenie klad’te na mimo dosah deti. Nedovolte detom pouzivat
bezdrotové zariadenie bez dozoru.

Nedovol'te detom dotykat sa malého prislusenstva. V opacnom pripade
mézu malé casti sposobit’ udusenie alebo zapchanie hrdla pri ich
prehltnuti.
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Miesto prevadzky

Bezdrotové zariadenie nie je vode odolné . Udrzujte ho v suchu. Chrante
bezdrotové zariadenie pred vodou a parou. Nedotykajte sa bezdrotového
zariadenia mokrymi rukami. V opacnom pripade moze nastat’ skrat, zlyhanie
vyrobku alebo zésah elektrickym pridom.

Nepouzivajte bezdrotové zariadenie na prasnych, vlhkych a znecistenych
miestach alebo miestach s magnetickym polom. V opa¢nom pripade to méze
sposobit’ zlyhanie obvodu.

Ked’ nesiete alebo pouzivate bezdrotové zariadenie, majte ho najmenej jeden palec
(2,5 centimetra) od tela, aby ste zabranili negativnemu vplyvu na Vase zdravie
spdsobené prenikanim vysokofrekvenénych vin.

Pocas dna s burkami, nepouzivajte Vase bezdr6tové zariadenie vonku.
Nedotykajte sa bezdrotového zariadenia pocas jeho prevadzky. Moéze to
ovplyvnit’ kvalitu prenosu a spdsobit’ vyssiu spotrebu bezdrotového zariadenia.
Bezdrotové zariadenie moze rusit’ TV prijimace a radia.

Vsulade s medzindrodnymi normami pre vysoké frekvencie a Ziarenie,
pouzivajte bezdrotové zariadenie len s prislusenstvom schvalenym spolo¢nostou
Huawei.

v
.

istenie a udrzba

Pred Cistenim alebo udrzbou bezdrotového zariadenia ho odpojte od Vasho
pocitata a vypnite pocita¢ PC. V opacnom pripade moze nastat’ skrat alebo
zasah elektrickym pradom.

Na Cistenie bezdrotového zariadenia nepouzivajte chemické Cistiace
prostriedky, prasky, alebo iné chemické ¢inidla (ako napriklad alkohol a
benzén). V opacnom pripade mdzete poskodit’ Casti vyrobku alebo spdsobit
poziar. Bezdrotové zariadenie mozete Cistit’ kusom jemnej, mierne navlhéenej
antistatickej latky.

Neposkrabte schranku bezdrotového zariadenia. Oskriabany povlak moze
sposobit’ koznu alergiu. Ak by sa tak stalo, prestaiite ihned pouzivat
bezdrotové zariadenie a navstivte lekara.

Ak bezdrotové zariadenie alebo ktorakol'vek z jeho Casti nefunguje, obratte sa
na miestne autorizované servisné stredisko.
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Starostlivost’ o zivotné prostredie

Dodrzujte miestne nariadenia o odstraiovani obalovych materialov, starého
bezdrotového zariadenia, pricom Vas prosime o uprednostnenie ich recyklacie.
Nezahadzujte staré bezdrotové zariadenie do kontajnerov na odpadky a
nehadzte ich ohna. M6ze nastat’ vybuch.

Informacia o certifikacii (SAR)

TOTO ZARIADENIE SPLNA VLADNE NARIADENIA O VYSTAVEN]
VYSOKOFREKVENCNEMU ELEKTROMAGNETICKEMU POLU.

Vake bezdrotové zariadenie je nizko vykonny vysiela¢ a prijima¢ vysoko-
frekvenénych vin. Pri prevadzke vyZaruje nizke hladiny vysokofrekvengne;
energie (tiez zname ako radiové viny alebo vysokofrekvencné pole).

Vlady Statov celého sveta prijali vSeobecné medzindrodné bezpecnostné
predpisy, vyvinuté vedeckymi organizaciami, napr. ICNIRP (Medzindrodna
komisia pre ochranu proti neionizujucemu ziareniu) a IEEE (Institute of Electrical
and Electronics Engineers Inc.), na zdklade pravidelného a dokladného
hodnotenia vedeckych studii. Tieto prepisy definuji povolené hladiny vystavenia
verejnosti posobeniu radiovych vin. Ich hodnoty zahriiaji bezpe¢nostné rozmedzie
uréené na zabezpecenie ochrany vsetkych osob v nezavislosti na veku a
zdravotnom stave, a na zohl'adnenie akychkol'vek odchylok pri merani.

Specificki absorpéna  davka (SAR) je mernou jednotkou mnoZstva
vysokofrekvencnej energie, ktoru telo absorbuje pri pouzivani bezdrotového
zariadenia. Hodnota SAR je definovand ako najvyssia certifikovand hladina
dosiahnuta v laboratornych podmienkach, ale skutoéna SAR hodnota bezdrétového
zariadenia pocas prevadzky moze byt vyrazne nizSia. To je spdsobené tym, ze
bezdrétové zariadenie je zostrojené tak, aby pouZzivalo minimalny vykon
potrebny na pristup na siet’.

Vsetky modely bezdrotovych zariadeni Huawei si vyvinuté v sulade s
predpismi o vystaveni vysokofrekvencnej energii ako st Odporucanie
Eurépskej rady a Vyhlaska Federalnej komisie pre telekomunikacie (FCC -
Spojené staty).

Odporucanie Europskej rady: Skor, ako sa model bezdrotového zariadenia
dostane do predaja verejnosti, musi byt testovany podl'a technickej normy -
EN 50361 a nesmie prekracovat’ limit stanoveny Odporucanim Eurdpskej
rady: 1999/519/EC pre bezpecné vystavenie ziareniu. 1.

Limit SAR prijaty podl'a 1999/519/EC je 2,0 watt/kilogram (W/kg)
v priemere cez desat’ gramov latky. Najvyssia SAR hodnota pre tento typ
zariadenia pri testoch bola 1,20 W/kg.
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Vyhlaska Federalnej komisie pre telekomunikacie (Spojené §taty): Skor,
ako sa model bezdrotového zariadenia dostane do predaja verejnosti, musi
byt testovany a certifikovany podl'a FCC, ze neprekracuje limit stanoveny v
poziadavke na bezpecné vystavenie ziareniu, ako bola prijata vladou.

Limit SAR limit prijaty USA a Kanadou je 1,6 watt/kilogram (W/kg) v
priemere cez jeden gram latky. Najvyssia SAR hodnota hlasena FCC a IC pre
tento typ zariadenia je pri testoch na pouzivanie bola 0,59 W/kg.

Vyhlasenie zhody podla FCC

Toto zariadenie bolo testované a uznané v sulade s limitmi pre digitalne zariadenia
triedy B v casti 15 Pravidiel FCC. Tieto limity slizia na zaistenie primeranej
ochranu proti $kodlivému ruSeniu pri inStalacii v obytnych oblastiach. Toto
zariadenie generuje, pouziva a modze vyzarovat vysokofrekvencni energiu a
pokial’ sa nenainstaluje a nepouziva v sulade s pokynmi, méze sposobit’ skodlivé
ruSenie radiovej komunikacie. Avsak neda sa zaru€it, ze k ruSeniu pri urcitej
inStaldcii neméze dojst. Ak toto zariadenie spdsobuje Skodlivé rusenie prijmu
rozhlasu alebo televizie, ktoré sa da zistit' vypinanim a zapinanim zariadenia,
odporicame uzivatelovi pokusit’ sa o zabranit tomuto ruseniu jednym s
nasledovnych opatreni:

Preorientujte alebo premiestnite prijimaciu anténu.
Zvyste vzdialenost medzi zariadenim a prijimacom.
Pripojte zariadenie k vyvodu iného obvodu, ako na ktorom je pripojeny
prijimac.
Porad'te sa s predajcom alebo skusenym technikom pre radio/TV prijimace.
Toto zariadenie je v stlade pravidlami FCC cast' 15 a s RSS-210 Industry
Canada. Jeho prevadzka je povolend na zéklade splnenia dvoch podmienok (1)
toto zariadenie nesmie sposobovat’ skodlivé ruSenie, a (2) toto zariadenie musi
byt schopné prijat’ akékol'vek rusenie, vratane rusenia, ktoré moze sposobit” jeho
nezelani obmedzenie funkcie.
Upozornenie:
Zmeny alebo upravy vykonané na tomto zariadeni , ktoré nie su vyslovene
schvalené spolo¢nostou HUAWEI mézu mat’ za pri¢inu stratu autorizacie FCC na
prevadzku tohto zariadenia .
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1 5 Akronymy a skratky

A

C

D

E

G

APN

CPU
CS

DL
DNS

EDGE

GPRS
GSM

HSDPA

PS
PIN
PUK

S
SIM

UL
USB
USIM

WCDMA
WINS

Access Point Name (pristupové meno)

Central Processing Unit
Circuit Switched (prepajanie okruhov)

Downlink (prijimanie dat)
Domain Name Server (server)

Enhanced Data rates for Global Evolution (technologia)

General Packet Radio Service (technolégia)
Global System for Mobile communications (Standard)

High Speed Downlink Packet Access (medzinarodny S$tandard pre
vysokorychlostnl datovii komunikéciu v sietach UMTS)

Packet Switched (paketové prepdjanie)

Personal Identification Number (osobné identifikaéné ¢islo)
PIN Unblocking Key (osobny kod pre odblokovanie)
Subscriber Identity Module (SIM karta)

Uplink (posielanie dat)

Universal Serial Bus (univerzalna sériova zbernica)

User Service Identity Module (USIM karta)

Wideband Code Division Multiple Access (technoldgia)
Windows Internet Name Service (server)

Qon® )

Ver: V1.00 BOM: 31016787
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Vyhlasenie o zhode

Huawei Technologies Co., Ltd.
Adresa: Bantian Longgang District Shenzhen 518129 Guangdong P.R. China
tymto bona fide prehlasuje, Ze produkt

Nazov koncového zariadenia: HSDPA/UMTS/EDGE/GPRS/GSM USB modem
Obchodny nazov: HUAWEI E220 USB modem
Model: E220

ktory je predmetom tohto vyhlasenia, je zhodny s klu€¢ovymi poziadavkami a dalSimi
prislusnymi klauzulami stanovenymi v:

Smernici R&TTE 1999/5/EC

Smernici o nizkonapat'ovych zariadeniach (73/23/EEC)
dalej doplnené smernicou Rady 93/68/EEC

Produkt uvedeny vtomto vyhlaseni vyhovuje nasledujucim $Standardom a/alebo
pravnym predpisom:

Ochrana zdravia: EN 50 360: 2001, EN 50 361:2001
Ochrana pouzivatela: EN 60950-1: 2001

Elektromagneticka kompatibilita:
EN 301 489-1 V1.4.1, EN 301 489-7 V1.2.1, EN 301 489-24 V1.2.1

Frekvenéné spektrum :
EN 301 511 v9.0.2, EN 301 908-1 V2.2.1 , EN301908-2 V2.2.1

Doplriujuce informacie:
Produkt uvedeny v tomto vyhlaseni je oznaceny symbolom CE a kédom autorizovanej
osoby od roku 2006, podla Certifikatu (zhody) ¢islo E814697T-CC.

Preverené autorizovanou osobou:

CETECOM ICT Services GmbH, Untertiirkheimer StraBe 6-10, D 66117 Saarbricken,
Germany

Meno: Li Xiaolong Vydané dna: 30.5.2006
Titul: Manazér pre kompatibilitu (Regulatory Compliance Manager)
Podpis:

i %lu%
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